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pour la préparation et la
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Bio-distribution de molécules
radio-marquées (FDG)



. . P
m Imagerie prée-clinique

AMISSA: A Multimodality Imaging System for Small Animal
UTDM-X

Imagerie anatomique
Acquisition/reconstruction 20s—6 min
Résolution spatiale : 150—50 pym

Imagerie Fonctionnelle
Résolution spatiale : 800 um
Efficacité de détection : 0.014%

MTEP
_ _ Imagerie fonctionnelle
IRIS, Inviscan, (avril 2014) En cours de développement
_ Résolution spatiale : 1uL
Photonlmager, Biospace Efficacité de détection : >15%
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" Imagerie pre-clinique

Etude des facteurs influencant les performances
pour une nouvelle génération d'imageurs

Tomographie a Emission de Positons (TEP)

« Géometrie radiale vs axiale
« Matrice segmentée vs bloc monolithique

s ) : Modules de détection
« Modéele a imager (souris, rat, primate)

de rayonnement gamma

Tomographie a Emission Mono-Photonique (TEMP) * Mesure d’eénergie
* Mesure de temps

» Collimateur sténopé vs lames paralleles
« Matrice segmentée vs bloc monolithique
« Champ de vue

Besoin d’'une nouvelle électronique d’acquisition qui doit étre
fortement modulaire
pour étre adaptable a tous nos projets
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" Une acquisition modulaire

ASIC IMOTEP congu

o : ) : System-on-Chip (SoC) de Xilinx Transmission TCP/IP
par I'’équipe Imagerie Moléculaire

sur un lien Gigabit Ethernet

+ Expertise de I'équipe sur :
= Conception de carte électronique (schéma, simulation)

= Conception de PCB complexes (multi-couches, micro-vias)
= Empreinte d’ASIC a bonder
= Connectique des photo-détecteurs (ex. 1024 anodes sur 5x5 cm)

= Sous-traitance électronique

= Approvisionnement de composants : RS, Farnell, Digikey
» PCB : Techci (Grenoble), CSI Sud-Ouest (Toulouse)
» Montage des composants : service Micro-technique IPHC

= Banc de test fonctionnel et photo-détecteurs

+ un besoin de modularité

Nos réalisations et développement en cours
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Signaux de synchronisation

issus du module maitre

f 3

v

DDR3
SDRAM

A
v

Rl

" Diagramme d’un module de la DAQ
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Carte numérique commerciale

Vers le prochain module esclave
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+12V
+3,3V

FMC-LPC

Détecteurs + électronique frontale
I
v

Carte numérique
basée sur le Sytem-on-Chip
Zyng-7020 de Xilinx

Logique

SDRAM DDR3
512 MB ou 1 GB

programmable Processeur
ARM
Codage VHDL et Lecture des
Verilog données en FIFOs
et gestion de la
Ecriture des transmission des
données en données par
FIFOs protocole TCP/IP

Structure de I'interface numerique de lecture

* Lecture périodique

* Protocole TCP/IP standard
+ ARP, ICMP et DHCP

nicolas.chevillon@iphc.cnrs.fr

<« Alim +12V
Acquisition
Traitement
Ethernet
Gigabit
<] TCP/IP
113,16 MiB/s

Come and Kiss

Commercial Element and
: Keep It Small and Simple

---------------------------------------------------------
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Cartes numerigues commerciales

SOC Zynq-7020 + 512MB-1GB DDR3 + 128-512 Mb QSPi Flash + Gigabit Ethernet

Cartes autonomes

ZC702

Xilinx (USA)
183 x 170 mm
720 €

Zedboard

Avnet (USA)

156 x 132 mm

320 € (512 MB DDR3)

TB-72-020-EMC
Inrevium (JPN)
130 x 69 mm
750 €

System on Module : SOM
(néceéssite 'emploi d’une carte «Support»)

MicroZed

Avnet (USA)

102 x 57 mm

Connectique 1/0: 2 x FCi

265 € (402 € avec carte «Support»)

ZX3

Enclustra (CH)

68 x 30 mm

Connectique 1/0: SODIMM200

257 € (507 € avec carte «Support»)

TEO0720

Trenz (D)

50 x 40 mm

Connectique 1/0: 3 x Samtec LSHM
289 € (589 € avec carte «Support»)
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Cartes « front-end » de I'interface numeérique

Carte de test ADC
ADC8 FMC

8 voies ADC - 125 MHz
(LTC2195, Linear Technology)

ZedBoard

Carte de test ASIC
IMOTEP_FMC

1 ASIC IMOTEP

nicolas.chevillon@iphc.cnrs.fr Ecole d’électronique numeérique de I'IN2P3 2016 9




Architecture d’'un module de |la DAQ

o] [ 1L hay carte SYNCHRO_FMC 1 module
+3,3V T ST,
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Architecture d’'un module de |la DAQ

carte SYNCHRO_FMC 1 module
64 18 (développement interne) = 256 voies indépendantes,
5 - S0Mhz () 100 kHz / voie,
s - Rst_time (in)
- Start_run (in) ]
(en provenance d'une autre 55 mW / voie
| vl e a— AT carte SYNCHRO-FMC)
&
>S5
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5
s -
~q) ::: IH\'!'l
o o
-9 a0 =
o
C
o
X
=)
(U 4
C
2
o

Nappes Twinax 100 Q
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4 cartes filles « front-end » , d
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- Carte « front-end »

e Connecteur Montage de la puce IMOTEP :
u . B

: . 22 signaux numeriques > Fabrication de la puce:

6;1 sg{nagggotodetecteur t 3 Alimentatic e AMS CMOS 0.35 um

( amlec ) (Samtec QTH) » Technique de montage:

« Chip On Board » (COB)
» Bonding: service
MicroTechnique (IPHC)
» Fils de bonding: aluminium

= -- o If’&lél

u 19 '3 -mwhmhfv

B
19
o
(70 i TR

OOOOOOOODOOOOOODOOOODOOOOOOODOOOOOOOOOD

Puce nue Imotep ADC LTC2191
(Linear Technology)

Carte « Front-End » 64 voies:

» Dimension: 135 x 50 mm

» PCB: 12 couches / Classe 7 (isolement mini 100 pm)
/ Microvias 150 uym

Fabricant PCB: CSI Sud-Ouest (Toulouse)

400 composants Top et Bottom a ")
Taille mini de boitier CMS: 0402 dl'o;’ “'!l i it 9

Cablage des prototypes: service de MicroTechnique de I'lPHC t‘0bo O b'l” :
g prototyp 9 AT 1 e L6

YV VY
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. Association de modules

MASTER ZedBoard (ou autre) : carte numérique commerciale

64 basée sur le SOC Zynq7020
. e > Cat GigE
256 voies o4 Carte ZedBoard 1 Gbits/s
64 SynChrO \
64 Génération 50 MHz
PC GigE
SLAVE1 Acq g
64 > GigE
rt
256 voies 64 Si/:r?chero ZedBoard
o4 - Recalage 50 MHz 512 voies
64 (Pas de 18 ps)
PC
SLAVE?2 Acq
o4 =
64 SynChrO \
Recalage 50 MHz
64 (Pas de 18 ps) .
PC GigE -
SLAVES3 Acq
64 g }'
256 voies 64 | FE ——> Carte ZedBoard
64 SynChro Recalage 50 MHz 512 voies
64 (Pas de 18 ps) '
............ »
\ 4
4 x N cartes «Front-End» N modules N x 256 voies
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Résultats de mesures de photo-détecteurs

Source %?Na
Spectres en charge

(@)

20000

|, Hamarhatsu H3{64

10000

HIT count

5000

10 20 30 40 50
4000 “?)

Cristal LYSO

‘ ~ Si-PM
AdvanSiD ASD-NUVY3S-P-40

HIT count
N
[=3
o
o

1000

10 20 30 40 50
Charge (pC)

e Source ?2Na

e Cristal LYSO 3 x3 x5 mm?3

* Reésolution en énergie du PMT : 14,5 %
» Résolution en énergie du Si-PM : 11,2 %
En accord avec I'état de l'art...
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Résultats de mesures de photo-détecteurs

2 x 23 cristaux /2 x 23 mm

v

L T e I, ok

Matrice de 23 x 23 cristaux de LYSO <2 X 23 cristaux /2 x 23 om
de 0,98 x 0,98 x 6 mm3 (pitch =1 mm)

Projection 2D

j 1%

Mesure
] sur les 256 voies
i niiiiiii g d'un MA-PMT
SEEEEEEERE ¢ Hamamatsu H9500
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Conclusions du module d’acquisition

» Carte numérique d’interface de lecture performante et économique

* Transfert technologique de la carte numérique a la société Inviscan
 Exploitation a venir de 30 modules dans le projet « DigiPET » porté par la
société Inviscan en collaboration avec I'équipe Imagerie Moléculaire et la

société Streb&Well, et financé par la région, la BPI et 'eurométropole
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Processing System (PS)
10 Peripheral Reset
Eexngﬁera : Application Processor Unit (APU)
Clock . :
2% 120 Generation SwoT NEOMN/FPU Engine NEON/FPU Engine
TTC
2x CAN e Cortex-A9 S Cortex-Ag
2x UART SLFSIB:“ MPCare CPU MPCore CPU
e
&) Control 32KBI  32KBD 32KBI  32KBD
2x SD/SDIO Regs Cache Cache Cache Cache
withOMA  —_] y  GIC Snoop Control Unit e
b I'bl‘lfl.?! + 2x USB : — Dvag 1 512 KB he & Controll
(MIO) with DMA — “Ehannel . L2 Cache & Controller
ox GidE ¥ OcM 256 KB OCM
X Gig
0 — ooty || ErEOMEt | octhoM
Central e
FLASH Memory Interconnect |
Interfaces +—1— DAP
“ SRAM/NOR y Memory Interfaces
NAND —1— DEVC Programmable =+ DDRZ/3, LPDDR2 +
Quad SPI LOGIC 10 MEMOTY ey Cantroller
Interconnect
! il il
Extended MID General Purpose DMA  Config IRQ High Performance XADC
(EMID) Master & Slave Ports  Sync ~ AES/ Ports
SHA
GTX AMBA Connection Legend Programmable Logic (PL)
(12,5 Arrow direction shows control, Data flows both directions
Ghps) Configurable AXI3 32 bit / 64 bit pC
AXI3 64 bit f AXI3 32 bit / AHB 32 bit / GEI_E

nicolas.chevillon@iphc.cnrs.fr
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o Fonctionnalités de la programmation Zynq

Besoin de la partie numérique du systeme d’acquisition :

» Lecture de données numériques par des liaisons séries LVDS en flux continu
» Filtrage des données non-pertinentes

» Retransmission des données sur une liaison Ethernet Gigabit par protocole TCP/IP

Interface ADC (x4) Désérialisation d’une liaison de données (x4)
Lecture énergie Lecture temps

FIFO 128 bits (16x FIFO 8 bits)

g i
t“sﬂ— AXI CDMA ' | Port Master AXI GPO et GP1 PS

Port ACP Cache L2 O Main : ARM en bare-metal (1 seul uP)
v [ Transfert de la FIFO vers 'OCM
On-Chip Memory DDR [ Filtrage et constitution trames TCP/IP
(OCM) v U Flush en DDR des données des trames
TEMAC O Routines d’interruption pour la gestion des
trames Ethernet
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Interface ADC en VHDL pour liaisons series LVDS

Fonction : dé-sérialiser les données ADC LTC2191 Zynqg\PL

issues d’'un ADC en conversion continue. FRAME_CLOCK
DATA_CLOCKOUT Interface

(B!ts |mpa|rS) DATA_1_A ADC
(Bits pairs) DATA_1_B
DATA_2_A
DATA 2 B

Utilisation du code source proposé par Marc Defossez :
xapp524 Serial LVDS ADC interface

Configuration :

» mot 16 bits

» 2 liaisons de données (1 pour bits pairs, 1 pour bits impairs)
» MSB first

Modifications apportées :
» « recablage » des primitives ISERDESE2
» recodage de la machine d’état BitClock
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Retour d’expérience de la primitive ISERDESE?2

SHIFTINT SHIFTOUTH

ISERDES : Input SERializer/DESerializer —{SHIFTIN2  SHIFTOUT2 |
Mots. —|OFB
ﬁ—D O
serie —{ppLY Ql|l—
Clk_Div | | | CEf Q2
CE2 Q3
Bit_Clk s Y A Y [ { A Y i SSI'-;LIP 84 | Mots
] 51— N
aralléle
DATA A A E B F DX HJX A Y —CLK as|— | P
X AXEeEXBYXFXcXGXDYXHYAYZ g e ol
—{CLKDIV Qs |—
CLKDIVP
Conditions d’utilisatio n telles que dans la note d’application —{DYNCLKDIVSEL
— | DYNCLKSEL
xa99524 . —locLK

« MODE = "MASTER"

« INTERFACE_TYPE = "NETWORKING"
« IOBDELAY = "NONE"

« DATA_RATE = "SDR"

« DATA_WIDTH = 4

Bit_Clk | [

mot 4 bits [ABCD]
AJE[BIFICIG[DIH A ISERDESE2 p [—>

OCLKB ISERDESE2

mot 4 bits [EFGH
A|E[ B|F|C|/G|D|H|A SERDESE2 N | [ ]
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Retour d’experience de la primitive ISERDESE?2

Comportement de I'ISERDESE2 fonction du branchement des entrées CLK et CLKB :

D’aprées la documentation :
Si ISERDESE2_p/CLK = BitClk, ISERDESE2_p/CLKB = /BitClk
Et ISERDESE2 n/CLK = /BitClk, ISERDESE2_n/CLKB = BitClk

ISERDESE2_p ——> mot 4 bits [ABCD]
A EBFCGDHA <

ISERDESE2_n |—> mot 4 bits [ABCD]

Par expérience :
Si ISERDESE2_p/CLK = BitClk, ISERDESE2_p/CLKB = Low
Et ISERDESEZ_n/CLK = /BitClk, ISERDESEZ_n/CLKB = Low

ISERDESE2_p |—> mot 4 bits [ABCD]
AEBFCGDHA <

ISERDESE2_n ——> mot 4 bits [EFGH]
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« Block design » du projet Vivado

M

%= Diagram X [ Address Editor X -

] & system »

%
L“\'

ananitll

[a|

= ZYNQ t A

QRO QN LA =L

E

File -> Export -> Export Block Design : export en fichier texte du « block design » en
équivalent script Tcl (ex. block design.tcl).
(le script pourra étre exécuté pour re-créer le « block design » en mode graphique)
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Gestion de project avec Vivado par scripts Tcl

Méthode de création des sources du design du PL :

» Création et constitution du design en mode projet sous Vivado

» Création du script Tcl permettant de recréer le projet Vivado graphique tel qu’il est:
File -> WriteProjectTcl : création du fichier script_create Vivado project.tcl

» L'exécution de ce script aboutit a la création du fichier projet .xpr
» Le script contient toutes les propriétés du projet :
» Le nom du FPGA cible, le langage préférentiel (ex. VHDL), ...
» La configuration des étapes de synthése et d’'implantation

» Le script appelle le script du « block design » block_design.tcl

» Gestion du multi-plateforme : un seul et méme code source définit pour plusieurs
cartes de développement Zynqg (ex. zc702 et Zedboard) : apres I'appel au script du
« block design », il faut gérer la spécificité de chaque carte en ré-exécutant
conditionnellement des commandes Tcl de création du design (ex. la ré-exécution de
la configuration du PS). La condition peut étre |la valeur d’'un argument passé a l'appel
du script script_create Vivado_project.tcl.

nicolas.chevillon@iphc.cnrs.fr Ecole d’électronique numeérique de I'IN2P3 2016 23



- Bootloader

Rendre le Zyng autonome en chargeant un ensemble bitstream + binaire de
I'application soft dans une mémoire flash externe (ex. mémoire QSPI)

Mode d’emploi dans SDK:

» créer une bootimage avec la commande Xilinx Tools -> Create Zynq Boot Image :
I'importation des fichiers nécessaires doit se faire dans un ordre précis : le binaire
du FSBL (First Stage BootLoader), puis le bitstream et enfin le binaire de son
application. Pour une mise en flash QSPI, exporter la bootimage en .mcs.

» programmer la flash avec la commande Xilinx Tools -> Program flash

Bootimage du projet PET
» Mise en flash d’un programme de boot a travers I'Ethernet

» chargement par le PC d’acquisition sur le Zynq du programme d’acquisition a
exécuter (chaque programme d’acquisition contient une commande pour revenir
au programme du bootloader) (ex. un programme par filtrage de données a
réaliser)
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